The University of Tennessee at Chattanooga
Annual Effectiveness and Assessment Data Entry

Campus Labs/Anthology — Planning Module
Entering and editing assessment and institutional effectiveness information

This handout describes the following actions and functions of the Campus Labs system.
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URL: https://utc.campuslabs.com/planning
or https://www.utc.edu/opeir and scroll down and click on ‘Assessment and
Institutional Effectiveness’ and then ‘Planning Login’.

Additional Resources
UTC Links on institutional effectiveness, assessment, planning, etc.

e https://new.utc.edu/academic-affairs/planning-evaluation-and-institutional-research/assessment-
and-institutional-effectiveness

SACSCOC web pages

e Accrediting Standards:
https://sacscoc.org/app/uploads/2019/08/2018PrinciplesOfAcreditation.pdf

e Institutional Resources: https://sacscoc.org/accrediting-standards/institution-resources/

e Policies and Publications: https://sacscoc.org/documents/?type=policies

e Accreditation Resource Manual: https://sacscoc.org/app/uploads/2019/08/2018-POA-
Resource-Manual.pdf (see page 66 [page 71 of the pdf] for information on Requirement 8.2 --
institutional effectiveness).

UTC Contacts (questions, to request access/permissions to the site and to specific areas, etc.)

April Matthews Cindy Williamson
April-Matthews@utc.edu Cynthia-I-Taylor@utc.edu
423-425-5684 423-425-4288
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Logging on to the UTC Campus Labs/Anthology system.

Navigate to https://utc.campuslabs.com/planning

Preferred browsers are Firefox, Safari, Microsoft Edge, Opera or Google Chrome. Internet

Explorer is not supported.

Enter your UTCID and password.

THE UNIVERSITY OF TENNESSEE

CHATTANOOGA

UTC Central Authentication Service

Log In with your UTCID. It will be similar to "abc123".
Log Out and Exit Your Web Browser when you are finished.

ter your UTCID and PasswW
urcIn: UTC Identity and Access Management:
To set or change your password or challenge guestions.
If you forgot your password or are a new user.

Password:
UTC Central Authentication Service:

. N The Central Authentication Service (CAS) protects and provides
O Warn me before logging me Into ot access to UTC applications. See a list of web services using CAS.

UTC Acceptable Use Policy:

You are required to comply with the University of Tennessee
policy on "Acceptable Use of Information Technology Resources”
when using UTC resources and services.

Questions? EEO Statement. Privacy
Statement.

University of Tennessee System

#®
FY 2017-18

j <| Dashboard

FILTER Sort  Default

My Items (30) Responsible Items (0) Contributor (1342)

You are not indicated as responsible for any items in FY 2017-18

Show 10 v Viewing 0-0of 0

Announcements

Welcome to the UT Chattanooga Strategic and Unit
Planning Site!

Welcome to UTC's tool to document, track and report on the strategic
planning and unit planning efforts of UT Chattanooga. As you
navigate through the system, ple... More

Resources & Links
Links and resources are provided below as well as the guide from the

initial training. UTC Links on institutional effectiveness, assessment,
planning, etc. ... More

Plans

Strategic Plan
Assessment Plan

General Education

Please be sure and review the announcements that are located on the right side of the screen.

Updates and Resources and Links will be posted here.
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Click on the Assessment Plans tab.

—3% Planning

5 FY 2017-18
» </ Dashboard
. Sort  Default v Announcements
iy e () S — Contributor (1342) Welcome to the UT Chattanooga Strategic and Unit

Planning Site!

Welcome to UTC's tool to document, track and report on the strategic
planning and unit planning efforts of UT Chattanooga. As you
navigate through the system, ple... More

You are not indicated as responsible for any items in FY 2017-18.

Show 10~ Viewing 0-0of 0
Resources & Links

Links and resources are provided below as well as the guide from the
initial training. UTC Links on institutional effectiveness, assessment,
planning, etc. ... More

Plans

Strategic Plan
Assessment Plan

General Education

On the left, click on Institution > Chancellor to find your office/department/program.

L FY 201718 v
& FY 2017-18 / ASSESSMENT PLAN
3 Assessment Plan v H H
. * <| Academic Affairs
My Units instigfftion .
& Plan ltems B Reports W Documents
Q  search.
FILTER Sort Default v =+ Plan Item ~
There are no plan items associated with the current Time Period, Plan, and Organizational Unit
Academic Affairs Show 10 v Viewing 0-0 of 0

Academic Services
College of Arts and Sciences
College of Business Administration

College of Engineering and Computer
Science

College of Health, Education, and
Professional Studies

Counseling and Personal Development
Center

General Education
Honors

Library
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FY 201718
5 Fy017-18 / ASSESSMENT PLAN
Pl v H H
& Academic Affairs
My Units 1MNgution

&Planitems =~ BReports M Documents

Q  search..
FILTER Sort  Default v =+ Plan Item ~

There are no plan items associated with the current Time Period, Plan, and Organizational Unit.

Academic Affairs Show 10 v Viewing 0-0of 0
Academic Services

College of Arts and Sciences

College of Business Administration

College of Engineering and Computer
Science

College of Health, Education, and
Professional Studies

Counseling and Personal Development
Center

General Education
Honors

Library

Make sure you have selected the correct Fiscal Year. If entering data from the past year, you will need
to change the year. If you are entering information on your plans for the current fiscal year, the
system should default to the correct year.

To Change the Fiscal Year
Click on the down arrow and select the correct fiscal year from the drop down menu. There is no
information in Campus Labs prior to 2014-15.

FY 201718

FY 2017-18 / ASSESSMENT PLAN
d TR 2010 locked

) . .
! | Institution
(locked)
I FY 2013 (locked) .
FY 2013-14 (locked) &Planitems B Reports M Documents
FY 20 (locked)

FY 20 (locked) FILTER Sort  Default v + Planltem ~

FY 201
FY 2017-1 There are no plan items associated with the current Time Period, Plan, and Organizational Unit
Che FY 201819 (locked)
FY 2019-20 (locked)
FY 202021 (locked) Show| 10 v Viewing 0-00of0

1
12

13

131
141
15-1
6-1

Inst

EEoEIs -
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Editing and Adding Data to Outcomes

To edit an outcome, click on the outcome for which you would like to edit or enter data.

v

FY 2017-18 / ASSESSMENT PLAN

" <|BAArt

R &
& Plan ltems B Reports

fitution
Documents

Sort  Def
Collaboration - Effective Jommunication, Community Engagement, Ethical & Responsible Behavior

5 wutcome

Technical Skills - Effective Communication, Critical Thinking

BA Art
Student Learning Outcome

Communication - Critical Thinking, Effective Communication, Comm Engagement, Ethical & Resp. Behavior

BA Art
Student Learning Outcome

Synthesis - Critical Thinking, Ethical and Responsible Behavior

This will open the outcome into Edit Mode.

Follow the directions for entering data in the missing fields from the instructions for Adding New
Outcomes on page 7 if entering a Student Learning Outcome and page 12 if entering a Service
Outcome.
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Adding New Outcomes

Click on the + Plan Item area.

FY 2017-18 / ASSESSMENT PLAN

| BA Art

&Paniems | BHReports M Documents

FILTER Sort  Default

L

=+ Plan Item ~

Collahoration - Effective Communication, Community Engagement, Ethical & Responsible Behavior Student Learning Outcome
BA Art Service Qutcome
Student Learning Outcome Curriculum Map

Technical Skills - Effective Communication, Critical Thinking
BA Art

Select what type of outcome you will be adding.

e Student Learning Outcomes (page 7) are outcomes that describe what students will know, be able
to do, etc. as a result of completing an academic program. (See
https://www.diabeteseducator.org/docs/default-source/education-and-career/ce-program-
accreditation/howtowriteobjectivesoutcomes.pdf for more information on student learning

outcomes.)
e Service Outcomes (page 12) are outcomes related to outcome
you might want as a result of providing service or programs for - T *+ Plan item ~

students and other constituencies (student support,
administrative, student development, etc.)

e The Curriculum Map item is a place where you can upload your
programmatic curriculum map if you wish and it is highly
recommended that you do so.

Student Learning Outcome
Service Outcome

Curriculum Map
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If you have selected to add a new Student Learning Outcome, a form will come up asking for the
information highlighted below for each field.

FY 2017-18 / ASSESSMENT PLAN
<| Edit Plan Item

Template: Student Learning Qutcome

Department/Degree Major *
BA Art

Student Learning Outcome Title *

Enter a Student Lear

ome that clearly states the expected knowledge, skill, or competency the students are expect:

0 demonstrate as a result

New Student Learning Outcome Item

Student Learning Qutcome Description

Enter description of the

File~ Edit~ WView~ Insert~ Format~

Formats ~ B 7

Powered by tinymce

Student Learning\Outcome Title: Enter a shortened version of the outcome that summarizes the main
idea. (If the outcoine relates to critical thinking, please add that to the title).

Student Learning Outcome Description: Enter the description of the outcome that is being assessed.

Academic/Fiscal Year Outcome Last Assessed: Enter the academic/fiscal year that the outcome was
last assessed. If it is a new outcome put ‘New’ in the field.

Academic/Fiscal Year Outcome Last Assessed /

Please indicate the last time this outcome was assessed.
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Comprehensive Exam

Critical Thinking Test
Embedded Course Work
Internship/Practicum/Capstone

Licensure Exam

Select a Means of Assessment: Select from the menu list. You can o .

] . ral defense/Presentation
select more than one means of assessment. If you are assessing using Portfolio
a rubric, attach the file or folder that contains the rubric. If you are i [ Publications
assessing in a way other than those listed, please select “Other” and Rubric
enter the type of assessment in the next field.

Senior Exit Exam

If Means of Assessment is "Rubric”, please attach the file ‘ + File H + Folder

There are no attachments.

If Means of Assessment is "Other" please specify
If Means of Assessment is "Other” please list what the assessment is.

File- Editr WView~ Insert~ Format~ Table~

Formats» B [ =

i
i
lil
lil
%
IF]

Powered by tinymce

F R U S e

Relation of Means of Assessment to the Outcome: Describe how the means of assessment is related
to the outcome.

Relation of Means of Assessment to the Qutcome

Describe how this means of assessment is related to the outcome.

File Edit View Insert Format Tools Table

7 —

S Paragraph V B I = = =

Il
lii
Il
i
<
iii
4
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Courses Associated with the SLO: If the Student Learning Outcome is addressed in specific courses,

enter those in the nextfield/

Course(s) associated with SLO 4

Enter courses associated with this Student Lea

ing Qutcome.

File = Edit~ View - Insert ~ Format ~ Table ~

Fomats~ B [T = =

1]
1]
iii
if
il
il
%
(4]

Powered by tinymee

If Means of Assessment is "Embedded Coursework” which course
If Means of Assessment is "Embedded Course” which course is the SLO embedded.

File= Edit~ WView~ Insert~ Format~ Table~

Formats~ B T

'
[}
1}
[}
it
i
lil
il
%
7]

Powered by tinymce

Criteria for Success

For each assessment type, enter the beginning status, or number. to which you will comp!

File = Edit~ View - Insert ~ Format ~ Table ~

Formats = B 7 = =

Powered by tinymce

If Means of Assessmentlis “Embedded Coursework” which course: Enter the course in which this
outcome is assessed.

Criteria for Success: For each assessment, enter the beginning status, or number, to which you will
compare results.
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Assessment Data: Enter a summary of the assessment data in this field. Note: This would be where
you begin updating your information to wrap up the annual assessment. If you have assessment data
you’d like to upload, click on the appropriate button (File or Folder).

Assessment Data (Results)

to enter your data. Once the information is entered, click update to save. You can include attachments (wor

Filer Edit~ View~ Insert~ Format> Table~

il
1]
i

ifi
lil
il
S
[r)

Fomas~ B [f = =

Powered by tinymce

Attached Files

‘ + File H =+ Folder

There are no attachments.

Status and improvements made during the Fiscal Cycle

—

File ~ Edit = View - Insert - Format - Table ~

M
]
]
]
iii
il
Il
il
%
(2

Formats ~ B 7

Powered by tinymce

Follow Up Actions Planned

Edit = Wiew

Formats ~ B 7

Powered by tinymce

Status and improvements during the Fiscal Cycle: Enter any information related to what your
department did based on the data during the cycle. This might include curriculum revisions, syllabus
revisions, course redesign, program redesign, etc.

Follow Up Actions Planned: Enter any additional actions that will be taken in upcoming years
addressing this outcome. For example, if the curriculum process is not complete or if some of the
actions will take more than one academic year to complete, enter a short plan here. State how you
will use the results to make improvements going forward. You are required to complete this field (as
well as the Outcome, Academic/Fiscal Year Outcome Last Assessed, Means of Assessment, Criteria
for Success, and Assessment Data fields)!
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Continuous Improvement: Describe how continuous improvement efforts are related to previous
assessment results.
Continuous Improvement

£

Describe how continuous improvement efforts related to previous assessment results.
File Edit View Insert Format Tools Table
_ = — — —_ T — -
Paragraph B I = = = = 2= = =

Do not change these dates. The system defaults to the fiscal year you selected at the beginning of the
process. Start (DO NOT CHANGE) *
> o
The Progress field selection can be used to note the progress of the End (DO NOT CHANGE) *
assessment for this outcome and if the outcome will continue to be ——
assessed.
e Evaluating this cycle: The outcome will be assessed during
this assessment cycle. ) ’ .
e Completed — Ready for Review: The outcome assessment Comhe ooty for Revice
process is completed for the year and is ready for review. Canceed: Outcome No Longer Applies
e Not Assessed this Year: The assessment for this outcome
is/was not a priority at this time and was not assessed this fiscal/academic year.
e Canceled: The outcome no longer applies to the program or area and should not be included in

future years.

Progr
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If you have selected to add a new Service Outcome, a form will come up asking for the information
highlighted below. Enter the information for each field.

.
FY 2017-18 / ASSESSMENT PLAN

<| Edit Plan Item
Template: Service Outcome

Department *
Institution
Title *

New Service Qutcome ltem

Department Goal (Long-term)

This is & broad overall statement and is not necessarily measurable

File = Edit ~ View ~ Insert ~ Format ~ Table ~
Formats ~ B 7 = =E = =E = = = E &F M
Expected (including targets)
Insert~ Format ~  Table ~
Fomats~ B J E E = E = iE & = &F M

Powered by tinymce

Titlef Enter a shortened version of the outcome that summarizes the main idea. (If the outcome
relgftes to critical thinking, please/add that to the title).

Department Goal: Enter (typefor copy/paste using the editing tools). This is a broad overall statement
and is not necessarily measurable.

Outcomes Expected: These are what you will be measuring.

Academic/Fiscal Year Outcome Last Assessed: Enter the academic/fiscal year that the outcome was
last assessed. If it is a new outcome put ‘New’ in the field.

Academic/Fiscal Year Outcome Last Assessed /

Please indicate the last time this outcome was assessed.
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Strategies
Strategies you will take to achieve the outcome.

File~ Edit~ View~ Insert~ Format~ Table~

Formats ~ B 7

'
[l
]
]
i
i
il
il
%
(4

Powered by tinymce

Strategies: These are the strategies and techniques you will use to achieve the

Survey

outcome. Rubric
Mumber {Count)
Means of Assessment: Select from the menu list. You can select more than Dollars
one means of assessment. If you are assessing using a rubric, attach the file or Areas Impacted
. . . . R onse Ti

folder that contains the rubric. If you are assessing in a way other than those Ssponss Hime
H “ ” . . Other
listed, please select “Other” and enter the type of assessment in the next field.

If Means of Assessment is "Area Impacted", please specify
Indicate what area is being impacted due to Outcome.

File= Edit~ WView~= Insert~ Format- Table -

Formats~ B [ =

Powered by tinymce

+ File || = Folder

If Means of Assessment is "Rubric", please attach file

There are no attachments.

If Means of Assessment is "Other", please give descripti

If Means of Assessment is "Other", please give description.

File= Edit» View= Insert» Format-= Table =

Formats+ B 7 =

Powered by tinymce
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Relation of Means of Assessment to the Outcome: Describe how the means of assessment is related

to the outcome.

Relation of Means of Assessment to

Describe how this means of assessment is |

File Edit View Insert Format Tools Table

S ¢ B I

Paragraph

Criteria for Success: For each assessment, enter the
compare results.

Criteria for Success
For each assessment type, enter the beginning status,

File= Edit» View~ Insert~ Format- Table~

Formats =

B 7

Powered by tinymce

7 —

li
v
hil
11

beginning status, or number, to which you will

or number, to which you will compare the resuits.

F W
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Assessment Data: Enter a summary of the assessment data in this field. Note: This would be where
you begin updating your information to wrap up the annual assessment. If you have assessment data
you’d like to upload, click on the appropriate button (File or Folder).

Assessment Data (Results)

to enter your data. Once the information is entered, click update to save. You can include attachments (wor

Filer Edit~ View~ Insert~ Format> Table~

ifi
lil
il
S
[r)

Formats B 7T = =

Powered by tinymce

Attached Files

‘ + File H =+ Folder

There are no attachments.

Status and improvements made during the Fiscal Cycle

File ~ Edit = View - Insert - Format - Table ~

]
]
Il
]
i
i
il
lil
%
2]

Formats ~ B 7

Powered by tinymce

Follow Up Actions Planned
il rs addres: sing this outcorme. For example. if the curriculum process is ’?CfCC-"T-'S-'E':_‘ or if sorme of

the a

File ~ Edit =

Wiew

Formats ~ B 7 =

Powered by tinymce

Status and improvements during Fiscal Cycle: Enter any information related to what your department
did based on the data during the cycle. This might include curriculum revisions, syllabus revisions,

course redesign, program redesign, etc.

Follow Up Actions Planned: Enter any additional actions that will be taken in upcoming years
addressing this outcome. For example, if the curriculum process is not complete or if some of the
actions will take more than one academic year to complete, enter a short plan here. State how you
will use the results to make improvements going forward. You are required to complete this field (as
well as the Outcome, Academic/Fiscal Year Outcome Lase Assessed, Means of Assessment, Criteria

for Success, and Assessment Data fields)!
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Continuous Improvement: Describe how continuous improvement efforts are related to previous
assessment results.
Continuous Improvement

T crriihe henar o o e i ravarmant offnr ~af
Describe how continuous improvement eimoris rei

File Edit View Insert Format Tools Table
Paragraph B I = = = = = = =
Do not change these dates. The system defaults to the fiscal year Start (DO NOT CHANGE) *
you selected at the beginningoftire-preceass 07/01/2017

‘) End (DO NOT CHANGE) *

06/30/2018

The Progress field selection can be used to note the progress of the
assessment for this outcome and if the outcome will continue to be
assessed.
e Evaluating this cycle: The outcome will be assessed during .
this assessment cycle. o e e
e Completed — Ready for Review: The outcome assessment Cancalod: Outcome No Longer Applis
process is completed for the year and is ready for review.
e Not Assessed this Year: The assessment for this outcome is/was not a priority at this time and
was not assessed this fiscal/academic year.
e Canceled: The outcome no longer applies to the program or area and should not be included in

future years.

Progress

UTC-Campus Labs-Combined Guide - 1.13.21 1/13/2021 page 16



The University of Tennessee at Chattanooga
Annual Effectiveness and Assessment Data Entry

Responsible Users

Other faculty and staff may be asked to enter, edit, or approve the assessment plans for the program.
In the Responsible User area (located on the right side
when adding or editing an outcome), those individuals
Responsible Users can be entered and given permissions to perform the
Select users from the list below or search for a specific user aCtIOI'\S they have been aSSIgned.

Q Start typing a user's name

2 Permissions 1l Related

Then click in the user’s name field. Enter the last name of the person you want to enter, which should
bring up all users with that last name. Select the person’s name you want to add by clicking on the ‘+
symbol beside their name. If you do not see the name you are looking for, contact OPEIR to have the
person added to Campus Labs.

Available Users

Select users from the list below or search for a specific user
Q | [Start typing a user's name

Melnik, Laurie Administrator
Zitkus, Sandy Administrator

Schurr, Andrea Reviewer

Role Types and Permissions:
e Administrator: Can add, edit, and delete any items/information for the department or any
level below.
e Contributor: Can edit and contribute to any of the data in the department. Contributors
cannot add or delete items.
e Reviewer: Read-only access to the items in the area or any level below the current level.

UTC-Campus Labs-Combined Guide - 1.13.21 1/13/2021 page 17



The University of Tennessee at Chattanooga
Annual Effectiveness and Assessment Data Entry

Relating Outcomes to the Institutional or College Strategic Plan and
the General Education Plan

Relating to the Institutional Strategic Plan:

To relate your outcomes (Service, Student Learning, or Program Outcomes) to the Institutional
Strategic Plan start by clicking on the title of the outcome. Once you are in the outcome on the right

side click on ‘Related’.

2a Permissions 1l Related ® History

Assign Responsible Users

Responsible Users

No responsible users have been added.

Think of your outcome and the strategic plan in terms of a ladder. Your outcome is at the bottom and
supports up the ladder, so you will click on ‘+ Supports’.

& Permissions Tl Related © History
Supports + Supports

(Connected Up)
No Connections have been added.

This Item

Supported By + Supported By
(Connected Down)

No Connections have been added.
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Click on the arrow in the box that says ‘Assessment Plan’ and change it to ‘Strategic Plan’. Make sure
the year is for the current fiscal year. Also, make sure that Institution is selected.

DEVELOP METHODOLOGY TO COLLECT FORMAL FE

Select a Supports (Re FY 201920

®_® Strategic Plan <=

FY 2019-20 -
=* Assessment Plan v Q search...
Q search.. | Institution

| Institution Chancellor
Chancellor \

When you click on the ‘+’ sign on the right you are adding that strategic plan item to your outcome.

Ll I B ] — = ’-------

FILTER
UTC Mission, Vision, and Values —
Institution
Mission, Vision, and Values 7/11/19-6/30/20
UG experiential learning H
Institution
1a:Strategic Objective 711/19 - 6/30/20

You can click on as many as appropriate for the outcome.

UTC-Campus Labs-Combined Guide - 1.13.21 1/13/2021 page 19



The University of Tennessee at Chattanooga
Annual Effectiveness and Assessment Data Entry

If you click on one and change your mind click on the ‘x’ to remove it.

Supports
(Connected Up)

UTC Mission, Vision, and Values [x)
Institution Mission, Vision, and Values
This Item

You can also link your outcomes to you specific College or Department if they have a Strategic Plan. To
do this for academic departments click on ‘Chancellor’, then on ‘Academic Affairs’, and then select
your college. For non-academic departments click on ‘Chancellor, and then select the division your
departmentisin.

Q, search...

Institution

Chancellor «=—"_

Academic Affairs

You can also link your outcomes with the General Education outcomes. To do this change from
Strategic Plan to General Education.

FY 2019-20 v
=-* General Education ]
Q, search...

This will bring up the Gen Ed outcomes and you can select all that are appropriate b clicking on ‘+’.
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